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i-Tree is a cooperative initiative



i-Tree is a state-of-the-art, peer-reviewed software suite from the USDA Forest Service 
that provides urban and community forestry analysis and benefits assessment tools. The 
i-Tree tools help communities of all sizes to strengthen their urban forest management 
and advocacy efforts by quantifying the environmental services that trees provide and 
assessing the structure of the urban forest. 

i-Tree has been used by communities, non-profit organizations, consultants, volunteers, 
and students to report on the urban forest at all scales from individual trees to parcels, 
neighborhoods, cities, and entire states. By understanding the local, tangible ecosystem 
services that trees provide, i-Tree users can link urban forest management activities with 
environmental quality and community livability. Whether your interest is a single tree or an 
entire forest, i-Tree provides baseline data that you can use to demonstrate value and set 
priorities for more effective decision-making.

Developed by USDA Forest Service and numerous cooperators, i-Tree is in the public 
domain and available by request through the i-Tree website (www.itreetools.org). The Forest 
Service, Davey Tree Expert Company, National Arbor Day Foundation, Society of Municipal 
Arborists, and the International Society of Arboriculture have entered into a cooperative 
partnership to further develop, disseminate, and provide technical support for the suite.

i-Tree Products

The i-Tree software suite v. 3.0 includes two flagship urban forest analysis tools and three 
utility programs.

i-Tree Eco provides a broad picture of the entire urban forest. It is designed to use field 
data from randomly located plots throughout a community along with local hourly air 
pollution and meteorological data to quantify urban forest structure, environmental effects, 
and value to communities.

i-Tree Streets focuses on the ecosystem services and structure of a municipality’s street 
tree population. It makes use of a sample or complete inventory to quantify and put a 
dollar value on the trees’ annual environmental and aesthetic benefits, including energy 
conservation, air quality improvement, carbon dioxide reduction, stormwater control, and 
property value increases. 

i-Tree Species Selector is a free-standing utility designed to help urban foresters select 
the most appropriate tree species based on environmental function and geographic area.

i-Tree Storm helps you to assess widespread community damage in a simple, credible, 
and efficient manner immediately after a severe storm. It is adaptable to various 
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community types and sizes and provides information on the time and funds needed to 
mitigate storm damage.

i-Tree Vue (Beta) allows you to make use of freely available national land cover data 
maps to assess your community’s land cover, including tree canopy, and some of 
the ecosystem services provided by your current urban forest. The effects of planting 
scenarios on future benefits can also be modeled. This program is a beta version, i.e., it is 
still in development and feedback is appreciated.

Disclaimer

The use of trade, firm or corporation names in this publication is solely for the information 
and convenience of the reader. Such use does not constitute an official endorsement or 
approval by the U. S. Department of Agriculture or the Forest Service of any product or 
service to the exclusion of others that may be suitable. The software distributed under the 
label “i-Tree Software Suite v. 3.0” is provided without warranty of any kind. Its use is 
governed by the End User License Agreement (EULA) to which the user agrees before 
installation.

Feedback

The i-Tree Development Team actively seeks feedback on any component of the project: 
the software suite itself, the manuals, or the process of development, dissemination, 
support, and refinement. Please send comments through any of the means listed on the 
i-Tree support page: http://www.itreetools.org/support/. You can also use the Report a Bug 
feature available under the Help menu right in the software itself. User feedback will allow 
these tools to be updated and improved!



i-Tree

Components of the i-Tree software suite have been developed over the last few decades 
by the USDA Forest Service and numerous cooperators. Support for the development and 
release of i-Tree v. 3.0 has come from USDA Forest Service Research, State and Private 
Forestry, and their cooperators through the i-Tree Cooperative Partnership of Davey Tree 
Expert Company, National Arbor Day Foundation, Society of Municipal Arborists, and the 
International Society of Arboriculture. 

i-Tree Storm

i-Tree Storm is an adaptation of the Storm Damage Assessment Protocol, which was 
cooperatively developed by the US Forest Service, Northeastern Area, the Northeast 
Center for Urban and Community Forestry, and the Davey Tree Expert Company. Principal 
developers included David Bloniarz, H. Dennis Ryan, Christopher J. Luley, Justin Stratton, 
and Jerry Bond. 

The Hurricane Adaptation was cooperatively created by Francisco J. Escobedo, School of 
Forest Resources and Conservation, University of Florida at Gainesville and Chris J. Luley 
and Jerry Bond of Urban Forestry LLC. 

Revisions for i-Tree Storm were carried out by members of The Davey Institute, including 
Steven Wisard, Michael Kerr, Lianghu Tian, and Scott Maco based on newly available 
research and feedback from i-Tree users. The manual was edited and designed by 
Kelaine Vargas.
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Introduction
i-Tree Storm, based on the Storm Damage Assessment Protocol Utility, establishes a 
standard method to assess widespread damage immediately after a severe storm in a 
simple, credible, and efficient manner. This assessment method is adaptable to various 
community types and sizes, and it provides information on the time and funds needed to 
mitigate storm damage.

Sample street segments are randomly chosen in a community, a survey is performed, 
and time and cost estimates are reported. A template developed in MS Excel carries out 
all computations and estimates the costs for hazard mitigation and debris cleanup across 
the entire community. A PDA application is available to help with data collection and paper 
forms are available for those choosing or needing to do this work manually.

The protocol includes an optional pre-storm stage that evaluates a community’s street-side 
trees and provides a rough estimate of the cost of cleanup that might be needed after a 
severe storm. A special Hurricane Adaptation (beta) module is also available that makes 
use of historic data to improve estimates for these kinds of storms. This version is still in 
development and feedback is encouraged.

For more information on the underlying Storm model, see “An Initial Storm Damage 
Assessment Protocol for Urban and Community Forests” on the i-Tree website, www.
itreetools.org under Resources.

About This Manual

This manual provides all the information needed to conduct a Storm project. We begin with 
directions for installing the software and move on to the three project phases:

Phase I: Getting Prepared: In this section, we talk about decisions that need to be made 
right at the outset, such as how, when, and what kind of data will be collected. Phase I 
also includes helpful hints on general emergency preparedness, including planning for 
communication, personnel, and back-up and storage. During this phase, you will also 
gather general data, such as cost estimates for emergency work crews. Finally, you’ll 
create your random sample of plots and prepare the PDAs or manual forms for data 
collection. 

Phase II: Before the Storm: If you’ll be conducting a pre-storm survey of your sample 
plots, in this section, we explain what data to collect and how to use the PDA or forms to 
do so. After data collection, you’ll transfer the data to the desktop, answer some set-up 
questions, and view the results of your analysis.

Phase III: After a Storm: This section covers the data that need to be collected after a 
storm and describes how to use the PDA or forms to do so. After data collection, you’ll 

http://www.itreetools.org
http://www.itreetools.org
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transfer the data to the desktop, answer some set-up questions, and view the results of 
your analysis.  

Appendix 1: Random Sample Workbook. Appendix I gives step-by-step instructions for 
one method for generating random plots using ArcGIS.

Appendix 2: Data Forms (Storm): All forms for conducting a regular Storm analysis are 
included here.

Appendix 3: Data Forms (Hurricane Adaptation): All forms for conducting the Hurricane 
Adaptation version are included here.
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System Requirements

Desktop/laptop computer requirements

Minimum hardware:

• Pentium or compatible 1600 Mhz or faster processor

• 512 MB of available RAM

• Hard drive with at least 500 MB free space

Software:

• Windows XP service pack 2 or higher OS

• Microsoft Excel

• For PDA users, ActiveSync 4.5 or higher for windows XP or Mobile Center 6.0 or 
above for Vista (included in i-Tree installation)

PDA requirements

• Windows Mobile 2003 or higher OS

Installation

To install Storm:

1  Visit www.itreetools.org to download the software or insert the i-Tree Installation 
CD into your CD-ROM drive. 

2  Follow the on-screen instructions to run the i-Tree setup.exe file. This may take 
several minutes depending on which files need to be installed. 

3  Follow the Installation Wizard instructions to complete the installation (default 
location recommended). 

You can check for the latest updates at any time by clicking Help > Check for Updates.

Components

The installation package includes three Storm components: an Excel Template, a PDA 
application, and an Interface that connects the two. The PDA application runs on the PDA 

Installation
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and was specially designed to be used for collecting data for Storm. The Excel Template 
runs on your desktop and uses the data collected during the inventory to perform all of the 
calculations related to estimating the total storm damage for your community. The 
Interface transfers your random sample data to the PDA and, after data collection, 
transfers the information from the PDA into the Template. The Interface is also the easiest 
place to manually enter your plot information if you created your random sample without 
using GIS. 
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General Emergency Planning

i-Tree Storm belongs within the general context of a community’s emergency planning and 
emergency response. Such planning is critical for an appropriate and timely response by a 
community after a disaster, and it is highly recommended that a general plan for 
addressing storm damage to your urban forest be created. A very useful guide for 
community officials can be found in the Tree Emergency Plan Worksheet (L. Burban, J. 
Hermann, and K. Himanga). Tree managers will also profit from consulting Storms Over 
the Urban Forest (L. Burban, J. Andresen). More information about both can be found on 
the i-Tree website, www.itreetools.org, under Resources.

Data collection personnel

Data collection after a storm depends critically on having trained damage assessors ready 
to work. Assessors can be recruited from various groups, depending on the community:

Community Staff

Tree Professionals

Volunteers

All assessors will need hands-on training for data collection. It is strongly recommended 
that the training be conducted during the pre-storm period because it is very difficult to 
do under emergency conditions. It is not necessary that the assessors be extensively 
experienced in estimating debris volume, labor time, or costs. The assessment system is 
set up to minimize the need for specialized experience.

Volunteers typically require more training, as well as motivation and oversight, so that 
anyone interested in using volunteers for Storm data collection would do well to consult 
resources on working with volunteers. NOTE: Caution is urged in involving volunteers in 
post-storm data collection for safety reasons.

It is best to use the same assessors for the pre-storm and post-storm surveys. They 
should have the following qualifications: 

• Some familiarity with trees and tree work 

• Available time under emergency conditions

• Local residence

If a community decides to establish sample plots using in-house staff and contract out the 
actual damage assessment, the person doing the post-storm assessment must be trained 

Phase I: Getting Prepared
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in advance on plot location, data entry, and the protocol used to assess the sample plots.

Back-up and storage

Be prepared for different scenarios by creating a flexible plan for post-storm work. 
Anticipate difficulties reaching your office, power outages, and trouble with transportation. 
Careful planning will minimize hassles during the emergency:

• Two separate sets of the plot information should be maintained and stored in 
different locations. 

• Electronic equipment must be kept ready for use. PDAs must be kept charged 
or have fresh batteries if they accept batteries. Because disasters are often 
accompanied by power failure, a laptop is preferable to a desktop as a host 
computer.

• Paper data-collection forms should be printed and stored with pencils, sharpener, 
and clipboards.

Communicating results with the proper officials

Data summaries for each community need to be communicated to the proper officials in a 
timely manner if the storm damage assessment effort is to be worthwhile. For this reason, 
local, state, and federal contact information should be archived with the storm assessment 
protocol information. This contact information can be recorded in Form 6 in Appendix 2.

Transmission of the post-storm assessment information can be completed using pre-
determined reporting methods, such as telephone, fax, E-mail, or overnight mail. More 
than one method should be set up because of the likely interruption of communications 
during a major storm event.

Early Decisions to Be Made

Before you get started with Storm there are several decisions that must be made. 

What kinds of storms do you anticipate? Ice storms, hurricanes and floods, smaller-
scale disasters?

Different disaster types present different damage and debris profiles, requiring some 
adjustment to the use of Storm. 

Ice Storms: Ice storms tend to have relatively widespread and uniform damage, and the 
debris is almost exclusively vegetative. Furthermore, the ice-laden debris usually remains 
at its initial landing place and is not moved around by natural forces. These characteristics 
permit quick, accurate estimates of potential and actual damage and costs from a small 
random sample.
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Hurricanes and floods: Hurricanes and many floods also produce widespread damage, 
and Storm will work well to produce a quick estimate of actual damage and costs. A 
Hurricane Adaptation has been incorporated into Storm that makes use of actual data 
and practices from a 10% random sample of communities in Florida following the 2004-
2005 hurricane seasons. For pre-storm assessments, the Hurricane Adaptation version 
(beta) predicts average vegetative debris loads based on street mileage and a choice of 
three damage levels. Because general averages are used, the estimates tend to be more 
accurate at the larger scale than at the very local level.

More detailed methods of estimating potential hurricane damage on the local level 
have been developed by the U.S. Army Corps of Engineers, Diana Umpierre and Glenn 
Margoles of Broward County, FL, and FEMA. More details on these methods can be found 
at the i-Tree website, www.itreetools.org under Resources.

Smaller-Scale Disasters: Smaller-scale disasters, including tornados, derechos (straight-
line storms associated with thunderstorms), and some floods, present sampling problems 
since they affect smaller areas. To estimate the damage caused by smaller-scale 
disasters, the following procedure may be used:

Determine the rough geographic area affected by the disaster. It may be necessary 
to assess this based on a quick survey of the area, for example, by driving toward the 
area from different directions and noting where the damage begins, or by using aerial 
data if available.

Draw a boundary around the affected area on a street map or in the GIS file used for 
sampling. 

Determine the total street miles in the affected area using the scaled map or standard 
GIS tools. 

Establish a suitable sample of the street segments in the area.

Once this adjustment has been made, the post-storm process can be completed as 
described below. 

Hurricane Adaptation users must also decide: Will you separate estimates for tree 
removal and tree pruning from estimates of debris removal?

The data collection protocol differs slightly depending on whether you will bid out 
emergency work in a lump sum for debris (including pruning and removal), or instead break 
it up by handling the emergency tree pruning and/or removal with a different contract.  

Will you collect data before and after or just after a storm?

Collecting data before a storm offers several advantages. First, it orients you to the 
plots—their location, condition, the best route to visit them. Knowing what to expect can 
make data collection after a storm much easier. Second, Storm will provide an estimate of 

http://www.itreetools.org
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anticipated damage to help you with disaster preparation planning. Finally, for the Storm 
(non-Hurricane) version, data collected before a storm will be used to improve estimates 
post-storm.

Users of the Hurricane Adaptation version who have decided to group tree pruning and 
removal together with debris removal for estimations do not need to do pre-storm field data 
collection to estimate damage. For these users, storm damage estimates make use of 
historic data and are based simply on the total number of miles of streets in your community 
and the estimated level of damage (high, medium, low). If you are using the Hurricane 
Adaptation version and are keeping pruning and removal separate from debris removal, a 
pre-storm analysis that includes field data collection will provide valuable information.

Does your community include rural (unpopulated) roads? 

Data collection for rural roads differs slightly from data collection in populated areas. This 
is mainly because in populated areas FEMA will reimburse costs for debris that can be 
hauled to the curbside by residents, so trees 50 ft beyond the right-of-way are included 
in estimations of potential debris. There are manual forms specifically for rural areas and 
rural plots can be identified in the plot list and PDA.

Will you collect data using (a) the i-Tree Storm PDA tool, (b) paper forms for manual 
data entry, or (c) a non-i-Tree platform?

The Storm software package includes a PDA application for use in data collection. 
Significant updates have been made for i-Tree v. 3.0, and the PDA application now works 
seamlessly from within Storm. The program will work with Pocket PC devices running 
Window’s Mobile 2003 (or later). 

If your community lacks funding to support the use of PDAs or you simply prefer to use 
an alternate method, that’s no problem. Data collection can be conducted using the paper 
forms in the Appendix, spreadsheets, etc. If you use the paper forms, data can later be 
entered directly into Storm’s Excel Template. If you would like to use a non-i-Tree platform, 
look over the data requirements on the forms to get an idea of what is needed. It’s a good 
idea to have the paper forms ready no matter what your decision, as storm-related power 
outages are likely.

Gathering General Data

Before Storm can calculate the time and money involved in clean-up, you must provide the 
program with a few numbers that are specific to your community: 

Total street mileage for all of the roads you manage

Determine the total centerline miles of public roads for which you will be responsible in 
an emergency. This number is absolutely critical. If this information is not immediately 
available, it can be obtained by any GIS technician using TIGER/Line files available for 
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free download as shape files from the Geography Network (www.geographynetwork.com).  
See the Appendix 1 for more information.

Estimated times required for pruning and removing trees by size class

Default values are given that can be adjusted for local conditions. You can enter your local 
values in the worksheet below.

Removal hours Pruning

DBH class Default Your values Default Your values

6–12 3.7 0.75

13–18 4.0 1.0

19–24 5.0 1.5

25–30 10.2 2.0

31–36 12.5 3.0

37–42 20.4 4.0

43+ 28.0 5.0

Rural (all trees) 6.2 2.5

Estimated cost per cubic yard for total debris management

This value includes all costs associated with hauling, reduction, and final disposal. 
According to the FEMA 2007 Debris Management Guide, eligible debris work under the 
Public Assistance Program must meet the following criteria:

• The debris was generated by the major disaster event.

• The debris is located within a designated disaster area on an eligible applicant’s 
improved property or rights-of-way.

• The debris removal is the legal responsibility of the applicant.

For more information, http://www.fema.gov/government/grant/pa/demagde.shtm

Estimated hourly rate for tree removal

Determine the anticipated hourly cost in your community for removing trees. Hurricane 
Adaptation users who are not separating tree removal from debris collection should skip 
this question.
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Estimated hourly rate for tree pruning

Determine the anticipated hourly cost for pruning trees. Hurricane Adaptation users who 
are not separating tree pruning from debris collection should skip this question.

Creating a Sample

Before pre- or post-storm data collection can begin, you must create a random sample of 
street segments in your community. This can be done in several ways, one of which is 
outlined in Appendix 1. What is critical for any sampling method is that it must follow simple 
random sampling conventions based on linear street segments to provide accurate results. 

We recommend creating a sample of 2% of street segments with a minimum of 10 and a 
maximum of 30. This has been demonstrated to yield an estimate of the damage that is 
within 5% of the true value if the degree of damage is relatively constant. It is also a good 
idea to select an additional 5 segments to serve as substitutes if necessary.

Be careful only to include eligible roads when creating your sample, which typically means 
excluding private or federal roads.

Regardless of the method you use to create your sample, the end result should be a 
simple random sample of street segments. In addition, you must know the total number of 
linear street miles in your study area. 

Loading or manually entering your sample list into Storm

If you used the method in Appendix 1 to create your sample, you can load it directly into 
Storm to save time during manual data entry or for use in the PDA. To begin: 

1  Open the Storm Interface from your computer’s Start menu > (All) Programs > 
i-Tree > Storm > Storm Interface. 

2  Click Import from Tiger Line, navigate to where you saved the .dbf file with the 
street segments in it and click Open. 

To check that the plot list has been properly created: 

1  Click Add/Edit on the Interface and the Plot Lookup Data Entry window will open. 

2  Click New if you wish to add more plots. If you want to make changes to a plot or 
remove it, highlight it and click Edit or Delete. 

3  TIGER/Line files do not include two pieces of information that you’ll need to know: 
ROW width and whether the plot is rural (unpopulated). These can be added here 
in the desktop interface or out in the field.

4  When you are satisfied with your list of plots, click OK to close the window.
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If you used an alternate method to create a random sample, the Interface is still the best 
way to enter general plot data into Storm. Click Add/Edit on the Interface, and click New 
to begin adding plots manually. [Note: Plots can also be added manually directly into 
the Storm Template, which can be accessed under your computer’s Start menu. See 
Transferring Data to the Desktop in Phase II or Phase III for more information].

Mapping your sample plots

Having a map of your sample plots will greatly simplify data collection. Appendix 1 provides 
directions on creating a map using the shapefile you created in GIS. If the random 
segments were created in a GIS using another method, the shapefile can be overlaid on 
digital aerial photos of the study area. If digital photos are not available or if the sample was 
created manually, segments can be located on a digital map or on paper maps. 

Preparing the PDA

In this section, we’ll describe how to get your PDA ready for data collection. If you’re using 
the paper forms for data collection, you can skip down to the next section. 

PDA configuration begins on your desktop. To get started:

1  Open the Storm Interface in your computer’s Start menu > (All) Programs > 
i-Tree > Storm > Storm Interface. 

2  You should have loaded your plot list into Storm using the Interface in the previous 
step. If not, do so now by clicking Import from Tiger Line and navigate to the 
location where you saved the TIGER/Line file. Click Open. 

3  To transfer the plot list to the PDA, first connect the PDA to your computer. Your 
computer must recognize your PDA. If it does not do so automatically, follow the 
instructions that came with the device to achieve this.

4  In the Storm Interface, click Sync Handheld Device and the Storm PDA Transfer 
window will open.

5  Your first step should be to see what software needs to be loaded on the PDA. 
To do so, click Check Status. If any components are missing, they will be shown 
in red and an Install button will appear. Click Install to add the necessary 
components and follow the instructions on the screen and on the PDA. 

6  Once the PDA is properly set up, click Send Project Configuration to PDA. The 
PDA should be ready for data collection. 

Exploring the PDA

We’ll cover the PDA application in more detail below, but for now take a moment to 
familiarize yourself with how it works. To access the program, select i-Tree Storm from 
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your PDA’s Programs menu. On the Storm main menu, click Next to get started. A 
window allowing you to Add Plots, Review Plots, and Delete Plots appears.

The Add Plots interface is the core of the PDA application. The first three windows allow 
you to enter (or select from the drop-down list) general information on the plot. Once the 
plot information is entered, you have a choice between PreStorm Tallies or PostStorm 
Tallies. PreStorm Tallies allows you to count trees on and off the ROW. Tapping within 
any box increases the count by one. Trees can be removed by toggling the Add button 
to Subtract and tapping on the box where you wish to remove a tree. PostStorm Tallies 
allows you to count trees that need removing or pruning and includes an additional window 
for entering debris to be removed. Once you’ve finished exploring, click Back and Abort to 
return to the main window.

The Review Plots interface brings up the list of all plots. You can select one and click 
Edit to make changes. The Delete Plots interface likewise brings up the list of all plots. To 
delete one, select it from the list and click Delete.

Preparing Paper Forms

Form 1 in Appendix 2 (Storm version) or Appendix 3 (Hurricane Adaptation) is the master 
list of all your plots. Transfer your sample list to Form 1, including plot numbers and plot 
lengths. Use additional sheets if necessary. Sum up the total length of all of the plots. Fill 
in the Total Street Miles for your community and calculate the Percent Street Miles.

If you are collecting data before the storm, you’ll need one copy of Form 2 for each plot. 
Have enough copies of the appropriate version (i.e., storm vs hurricane; A: populated 
areas, B: rural areas) to cover all of your sample street segments. 

If you are collecting data after a storm, you’ll need one copy of Form 4 for each plot. Have 
enough copies of the appropriate version (i.e., storm vs hurricane; A: populated areas, B: 
rural areas) to cover all of your sample street segments. 

Checklist

At the end of Phase I: Getting Prepared, you should have the following items ready:

• Printed list of random sample plots

• Printed map of sample plots

• PDAs loaded with sample plot list OR

• Form 1 filled out with all plots and enough copies of Form 2 (for pre-storm data 
collection) or Form 4 (for post-storm data collection) to cover all plots

To be ready to collect data immediately after a storm passes, these items should be stored 
somewhere in a safe place and ideally they should be duplicated with copies kept in 
different locations. 
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Preparing for Data Collection

PDAs

If you’re collecting data using PDAs, during Phase I, you should have loaded your PDA 
with your random sample segments. If not, return to those steps and take care of that now.

Paper forms

If you’re using the paper forms for collecting data, during Phase I, you should have 
completed Form 1, the master list of all of your plots, and prepared enough copies of the 
appropriate version of Form 2 (i.e., A: populated areas, B: rural areas; hurricane or storm) 
for all of your sample street segments. If not, do so now.

Tools

Before you head out into the field, you’ll need the following equipment:

• Map of sample plots

• Table of sample plot information, including plot number, start and end, street name, 
and length

• Biltmore stick or DBH tape for measuring DBH or for checking visual estimates

• Tools for manual data collection

• Form 1 to keep track of all plots to be visited

• Copies of Form 2 for each plot

• Clipboards

• Pencils (preferable) or pens

• PDA, configured and with sample plots loaded

• PDA case, on lanyard if preferred

• Extra batteries, battery pack, or mobile charger

• Extra stylus

Data Collection Before the Storm

To begin the field pre-storm survey, locate the first street segment (sample plot) on the 
map and head out to the field.

Phase II: Before the Storm
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What to measure

Your goal for each street segment is to count up all of the trees in each 6-inch DBH 
size class (DBH can be measured using a Biltmore stick, a DBH tape, or visually with 
occasional checks to confirm accuracy). Keep in mind the following restrictions:

• Count only trees that are alive.

• Count only trees that have a DBH ≥ 6 inches. 

• Count trees along both sides of the street and in the median if one is present.

• In rural (unpopulated) areas, count only trees that are in the public right-of-way 
(ROW).

• In populated areas, count trees in the ROW and within 50 ft of the ROW (keep 
track of them separately). 

• If a tree is on the edge of the ROW, follow local code if applicable to determine if 
it is a public tree. If necessary, make a visual estimate of the location of the trunk’s 
midpoint and if half of the trunk falls within the area to be tallied, count it.

No data on species or condition are to be collected. The purpose of the survey is simply 
to identify any tree that may require removal or pruning, or that may contribute brush that 
could fall or be dragged into the ROW after the storm.

What to measure: Hurricane Adaptation

If you are making use of the Hurricane Adaptation and you decided earlier in Phase I that 
you would keep track of tree removal/pruning separately from total debris, follow the above 
guidelines for tallying trees, but only count those in the ROW. 

Data collection using manual forms

For each plot, select the appropriate version of Form 2 (i.e., A: populated areas, B: rural 
areas; hurricane vs. storm). Fill out the header information including the address data, 
date, plot length, and ROW width. If the plot is not a typical city block, describe the start 
and end of the plot.

NOTE: If the exact ROW is not known, use your judgement in the field based on 
location of sidewalks, utilities, fences, etc. to estimate its boundaries. 

Note: If you are using the Hurricane Adaptation version, and you are NOT keeping 
track of tree removal/pruning separately from debris collection, you do not need to 
perform pre-storm data collection. You can skip directly to Data Analysis.
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The main part of Form 2 allows you to tally the trees in each size class using tick marks 
and then sum them at the end. Simply walk up one side of the street segment and down 
the other, making a tick mark in the “Tally” columns for each tree in the appropriate size 
class [keeping the ROW and Off ROW (ROW + 50) trees separate if applicable]. When 
you’re finished with the segment, count up your tick marks and write the number in the 
next column.

The remaining fields on Form 2 will be calculated automatically using the Storm Template. 
If necessary, they also can be calculated manually back at your desk following the 
instructions at the bottom of the form.

Data collection using the PDA

To begin data collection with the PDA:

1  Select i-Tree Storm from your PDA’s Programs menu. 

2  Click Next on the main window to get started. 

3  Click Add Plot, enter the Community name, and select a plot from the drop-down 
list. To add a plot that is not on the list, simply fill in the fields below. Click Next. 

4  Enter a ROW width and enter your name or initials under Collected By. Click 
Next. 

5  Enter a description of the plot start and end if the segment is not a typical block.

6  Click PreStorm Tallies to start counting trees. 

a  Walk up one side of the street segment and down the other, tapping the box 
in the appropriate size class to add trees in the ROW. 

b  If you make a mistake and need to remove a tree, click the Add/Subtract 
button to toggle to Subtract and tap to remove.

c  Once ROW trees have been added, click Next to do the same for Off ROW 
trees if applicable. 

7  When you’re finished, click Save Tallies to save your data. 

8  Return to the main menu to continue adding plots.

If you need to edit a plot once you’ve saved it, click Review Plots on the main menu, 
select the plot to be edited, and click Edit to make your changes.
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Transferring Data to the Desktop

PDAs

To transfer inventory data collected on your PDA to your desktop: 

1  Connect the PDA to the computer.

2  Open the Storm PDA Interface under your computer’s Start menu. 

3  Click Sync Handheld Device and then Retrieve Data from PDA. 

4  Click OK to close window. Your inventory data have now been uploaded to Storm. 

5  Click Export Data to Spreadsheets. 

6  The Community Values window will open, allowing you to enter the values you 
determined during Phase I: Getting Prepared. Click OK once you’ve entered your 
local costs and estimated hours. 

7  A Save File window will open. Navigate to your desired location for saving, give 
your project file a name, and click Save. Your data have been saved to the Storm 
Template (an Excel file).

8  Open Excel and open the file you created in the step above. Agree to Enable macros.

Paper

To begin transferring data from the paper forms to Storm:

1  Open the Storm PDA Interface under your computer’s Start menu.  

2  You should have loaded or manually entered your plot list into the Storm Interface 
during Phase 1: Getting Prepared. If not, do so now by clicking Import from Tiger 
Line and navigating to the .dbf file of the sample plots or by clicking Add/Edit and 
entering the plot information by hand. 

3  After all plots have been added, click Export Data to Spreadsheets.

4  The Community Values window will open allowing you to enter the values you 
determined during Phase I: Getting Prepared. Click OK once you’ve entered your 
local costs and estimated hours. 

5  A Save File window will open. Navigate to your desired location for saving, give 
your project file a name, and click Save. Your data have been saved to the Storm 
Template (an Excel file).
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6  Open Excel and open the file you created in the step above. Agree to Enable macros.

7  On the Home screen, choose between Storm and Hurricane from the Select 
Analysis drop-down list. 

8  For now, skip the remaining questions on the Home screen and click on the 
PreData tab at the bottom of Excel. 

9  Each row contains the data for one sample plot. Match up the plot number in the 
Template with the copy of Form 2 for that plot and transfer the data from the main 
box on Form 2 to the appropriate fields on the spreadsheet. 

a  You can create an entry form in Excel to make data entry easier by 
selecting all of the fields in the top row that you need (usually O1: AB1) and, 
from Excel’s main tool bar, clicking Data > Form. Click the Tab key to move 
from field to field and click Enter to move to a new record.

b  Remember to save your work frequently.

Data Analysis

Set-up questions

Once your data are entered, either manually for those using the form, or via the PDA 
interface for those using the PDA, you can begin data analysis. If necessary, open the Storm 
Template by opening the Excel file you saved in the previous step. Agree to Enable macros.

Be sure the correct analysis option (Storm vs. Hurricane) is selected at the top. The 
answers to Questions 1–4 and the final question (5 for Hurricane, 8 for Storm) related to 
local cost and time estimates should be filled in with the information you entered in the 
Interface. If not or if you would like to make changes, answer the questions based on the 
information you collected during Phase I: Getting Prepared. 

Question 5 for the Hurricane Adaptation asks which debris rate you want to use. This 
choice only affects Pre-Storm calculations and relates to the anticipated severity of the 
storm. You can switch between the three values and see how the results change. To begin, 
leave the default Medium value. 

If you are using the Storm version (non-Hurricane), you may provide more information for 
Questions 5–7 or you can leave them marked “Unknown.” The answers to these questions 
help determine the precision level of your results.

If you are using the Hurricane Adaptation and did not need to collect pre-storm 
data because you are keeping pruning and removal together with debris collection, 
you can join the instructions at this point by opening the Storm Template from your 
computer’s Start menu and saving it in your desired location with a new name.
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Question 5: What was the source of your tree density numbers? Storm makes use 
of average values of tree density to estimate the amount of brush debris that will be 
created, either for pre-storm estimates or to convert measures of canopy loss into 
cubic yards of debris. The default values come from the table belowa:

Estimated no. of 
trees/mile

Estimated no. of 
trees/100 ft

Cubic yards of 
debris/mile

Cubic yards of 
debris/100 ft

151–200+ 2.85–3.87+ 633.6 12

101–150 1.91–2.84 475.2 9

43–100 0.81–1.90 316.8 6

26–42 0.49–0.80 132 2.5

1–25 0.05–0.48 66 1.25

0 0 0 0

For advanced users, the default values can be adjusted in the Storm Excel Template 
under the Codes tab. If you change the values, select a response to Question 5 that best 
describes your method. Most users will wish to leave the default values as they are.

Question 6: What sampling method did you use? Select the most appropriate answer 
from the drop-down list.

Question 7: How did you get your post-storm information? Leave as unknown for pre-
storm data analysis.

Reports

Once you’ve answered all the questions, click the PreAnalysis tab to see your pre-storm 
estimates. The gray boxes contain the information you entered on the Home screen. The 
numbers of trees are taken from the PreData tab. The important numbers—the hours of 
labor, total costs, and total debris—are in the upper right hand corner. The most important 
number, the pre-storm estimate of major storm damage, appears in the purple box at the 
very top.

Printing

In Excel’s toolbar, click File > Print. The report has been set up to print the most important 
information: the results and the Removals and Hazard Pruning calculations.

aFor more information on how this table was created, see “An Initial Storm Damage Assessment 
Protocol for Urban and Community Forests” on the i-Tree website, www.itreetools.org under 
Resources.
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Once the storm has safely passed, data collection should begin as soon as possible and 
should be completed within 12 hours of the storm’s end. 

Preparing for Data Collection

PDAs

If you’re collecting data using PDAs, during Phase I you should have loaded your PDA 
with your random sample segments. If not, return to those steps and take care of that now.

Paper forms

During Phase I, you should have completed Form 1, the master list of all of your plots, and 
prepared enough copies of the appropriate version of Form 3 (i.e., A: populated areas, B: 
rural areas; hurricane or storm) for all of your sample street segments. If not, do so now.

Tools

Before you head out into the field, you’ll need the following equipment:

• Map of sample plots

• Table of sample plot information, including plot number, start and end, street name, 
and length

• Biltmore stick or DBH tape for measuring DBH or for checking visual estimates

• Tools for manual data collection

• Form 1 to keep track of all plots to be visited

• Copies of Form 3 for each plot

• Clipboards

• Pencils (preferable) or pens

• PDA, configured and with sample plots loaded

• PDA case, on lanyard if preferred

• Extra batteries, battery pack, or mobile charger

• Extra stylus

Safety

Safety is always a concern when data collection is being conducted in an urban 
environment, and standard precautions for urban settings should be taken. The risks are 

Phase III: After the Storm
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even greater, of course, in the case of post-storm data collection because the Storm 
protocol requires surveying the sample plots within 12 hours of a storm’s passage. 
Dependable communication with the local storm center or crisis coordinators via cellular 
phones, two-way radios, or other methods, and a reliable vehicle (four-wheel drive in 
winter storm conditions) are advisable.

Large disaster-level storms often produce hazardous conditions. Hazardous trees and 
tree parts will likely threaten streets and sidewalks. These can include large hangers 
up in the crown, whole trees that have become unstable, and large amounts of debris 
on the ground. Furthermore, it is common for electrical wires to have been lowered or 
downed, placing them in easy contact with humans. Since they often remain live, the post-
storm data collector must be on the lookout for them and stay away from them. Careful 
coordination with local utility officials will help reduce the risk to the data collector.

Data Collection After the Storm

To begin, locate the first street segment (sample plot) on the map and head out to the field.

What to measure

In post-storm data collection, three critical pieces of information are recorded (for the 
Hurricane Adaptation, you might have decided to group all of these together): 

• Number and size of trees requiring removal

• Number and size of trees requiring pruning to remove hazardous branches.

• The amount of brush debris generated.

Trees in the ROW requiring removal: Tally the number and size of trees in the ROW 
including the following:

• Trees that are partially down (such as trees that are partially uprooted or leaning 
against other trees). The tree should be counted if any part of the tree is on or may 
fall into the ROW.

• Trees that have significant crown damage (50% or greater of the crown lost) but 
are still standing can also be included as removals, since FEMA will permit such 

NOTE: You should follow a pre-planned, efficient route between plots, but be prepared 
to make use of other routes in the event the planned route is blocked. Movement may 
be restricted by debris or downed electric lines, making it difficult and dangerous to 
carry out the survey. Be on the look-out for hazards. The collection method detailed 
here may have to be modified on some plots for safety. Whenever modifications are 
undertaken, care should be exercised to keep quality as high as possible so that the 
final estimates will be accurate.
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costs. But good judgment should be exercised. Research and experience suggest 
that some species recover even large amounts of lost crown very well, that healthy 
young trees have a good chance of recovery, and that the further out from the main 
trunk crown loss occurs the less it threatens the tree.

• Do NOT include trees that are completely on the ground. These should be included 
in estimates of brush to be removed.

• Only trees in the ROW should be included.

Trees in the ROW requiring pruning to remove hazardous branches: Record the 
number and size of trees with broken or hanging branches that are two inches or greater 
in diameter and that are still in the crown of the tree. Please note that hazard pruning is 
restricted to the removal of hanging or broken branches. Additional pruning to correct 
ripped branches or make proper pruning cuts of broken branches is not included. Only 
trees in the ROW should be included.

Amount of brush generated: Record the amount of brush debris in the ROW (and for 
populated areas, within 50 ft of the ROW) that has been generated and must be removed. 
This can be calculated in two ways:

Crown loss: For each 100-foot stretch of your street segment, estimate the amount 
of canopy lost for all trees with a DBH ≥ 6 inch that are in the ROW (and in populated 
areas, within 50 ft of the ROW). Estimates should be made as the midpoint of 25% 
classes, i.e., 12.5% (0–25% canopy lost), 37.5 (26–50% canopy lost), 62.5% (51–
75%), or 87.5% (76–100%). For more information on estimating crown loss, see the 
related documents on the i-Tree website, www.itreetools.org, under Resources.

Cubic yards: For each 100-ft stretch of your street segment, estimate the actual 
volume of debris in the ROW (and in populated areas, within 50 ft of the ROW):

Begin by imagining a box that would hold the debris. If it is scattered about, 
imagine bringing it together. 

Estimate the length, width, and height of the box in feet. 

NOTE: If the exact ROW is not known, use your judgement in the field based on 
location of sidewalks, utilities, fences, etc. to estimate its boundaries. 

NOTE: The crown loss option can not be used for estimating debris if construction and 
demolition debris is also present. Thus, this method is not available for the Hurricane 
Adaptation.

http://www.itreetools.org
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Multiply those dimensions together and divide by 27 to convert to cubic yards. 

For example, a typical 100-ft stretch might have 50 ft of ROW to either side of 
the midline and be completely covered with debris to a height of 2 ft, giving this 
equation: 

100 ft (length) x 200 ft (width) x 2 ft (height) = 40,000 ft3 ÷ 27 = 1,480 yds3.

What to measure: Hurricane Adaptation

If you are using the Hurricane Adaptation version of Storm, the data you collect depends 
on whether or not you decided to estimate costs for tree removal and pruning separately 
from debris collection. If you are estimating removal and pruning separately, simply 
follow the instructions as they are above, and be sure to use the “Cubic yards” method to 
calculate the amount of debris.

If you are calculated pruning and tree removal together with debris, follow the directions 
above for the “cubic yards” method of calculating debris to be removed.

Data collection using manual forms

For each plot, select the version of Form 4 that is appropriate for the plot type (i.e., A: 
populated areas, B: rural areas; hurricane vs storm).  Fill out the header information 
including the address data, date, plot length, and ROW width. If the plot is less than a full 
block, describe the start and end of the plot.

The main part of Form 4 allows you to tally the trees in each size class using tick marks 
and then sum them at the end. Simply walk up one side of the street segment and down 
the other, making a tick mark in the “Tally” columns for each tree in the ROW that needs 
removing and each tree that needs a hazard prune by size class. When you’re finished 
with the segment, count up your tick marks and write the number in the next column. Then 
conduct your estimate of debris to be removed for each 100-ft stretch using either the 
crown loss or cubic yards method as appropriate and enter the value in one of the last two 
columns. If there are more than eight 100-ft stretches in a given segment, estimate the 
average per 100-ft segment for the remainder and enter under “Extra.”

The remaining fields on Form 4, including the totals and averages, will be calculated 
automatically using the Storm Template. If necessary, they also can be calculated 
manually back at your desk following the instructions at the bottom of the form.

Data collection using the PDA

To begin data collection with the PDA:

1  Select i-Tree Storm from your PDA’s Programs menu. 

2  Click Next on the main window to get started. 
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3  Click Add Plot, enter the Community name, and select a plot from the drop-down 
list. To add a plot that is not on the list, simply fill in the fields below. 

4  Click Next. Enter a ROW width and enter your name or initials under Collected 
By. Click Next. 

5  Enter a description of the plot start and end if the segment is not a complete block. 

6  Click PostStorm Tallies to start counting trees. The first window is for tallying 
trees that need pruning. Simply walk up one side of the street segment and down 
the other, tapping the box in the appropriate size class to count trees in the ROW 
that need pruning. If you make a mistake and need to delete a tree, click the Add/
Subtract button to toggle to Subtract and tap to delete. 

7  Once trees that need pruning have been added, click Next to move to the Hazard 
Removal window and count trees that need removal. 

8  Finally, click Next to estimate debris removal. You can switch between the cubic 
yards vs. percentage crown loss by clicking the button at the top. 

9  When you’re finished, click Next and Save Tallies to save your data. 

10  Return to the main menu to continue adding plots.

If you need to edit a plot once you’ve saved, click Review Plots on the main menu, select 
the plot to be edited, and click Edit to make your changes.

Transferring Data to the Desktop

PDAs

To transfer inventory data collected on your PDA to your desktop: 

1  Connect the PDA to the computer

2  Open the Storm PDA Interface under your computer’s Start menu. 

3  Click Sync Handheld Device and then Retrieve Data from PDA. 

4  Click OK to close window. Your inventory data have now been uploaded to Storm. 

5  Click Export Data to Spreadsheets. 

6  The Community Values window will open, allowing you to enter the values you 
determined during Phase I: Getting Prepared. Click OK once you’ve entered your 
local costs and estimated hours. 
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7  A Save File window will open. Navigate to your desired location for saving, give 
your project file a name, and click Save. Your data have been saved to the Storm 
Template (an Excel file).

8  Open Excel and open the file you created in the step above. Agree to Enable 
macros.

Paper

To begin transferring data from the paper forms to Storm:

1  Open the Storm PDA Interface under your computer’s Start menu.  

2  You should have loaded or manually entered your plot list into the Storm Interface 
during Phase 1: Getting Prepared. If not, do so now by clicking Import from Tiger 
Line and navigating to the .dbf file of the sample plots or by clicking Add/Edit and 
entering the plot information by hand. 

3  After all plots have been added, click Export Data to Spreadsheets.

4  The Community Values window will open, allowing you to enter the values you 
determined during Phase I: Getting Prepared. Click OK once you’ve entered your 
local costs and estimated hours. 

5  A Save File window will open. Navigate to your desired location for saving, give 
your project file a name, and click Save. Your data have been saved to the Storm 
Template (an Excel file).

6  Open Excel and open the file you created in the step above. Agree to Enable 
macros.

7  On the Home screen, choose between Storm and Hurricane from the Select 
Analysis drop-down list. 

8  For now, skip the remaining questions on the Home screen and click on the 
PostData tab at the bottom of Excel. 

9  Each row contains the data for one sample plot. Match up the plot number in the 
Template with the copy of Form 4 for that plot and transfer the data from the main 
box on Form 4 to the appropriate fields on the spreadsheet. 

a  Fields A–O should be filled in automatically using the plot information you 
entered or uploaded in the Storm Interface.

b  For fields P–V, labeled HzPrnXX, where XX represents the different size 
classes, fill in the number of trees requiring hazard pruning in each class. 

c  For fields W–AC, labeled RemvXX, fill in the number of trees requiring 
removal in each size class.
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d  In field AD, labeled CY, enter Y if you measured debris using cubic yards or 
N is you used the canopy loss method. 

e  Although fields AE–AN are labeled CanopyLoss, they should be used to 
enter debris estimates using either method (canopy loss OR cubic yards). 
In each field enter the amount of debris for one of the 100-ft segments. Use 
AN (CanopyLoss10) if you had a value in the Extra blank on Form 3.

f  Fields AO and AP (AvgCanopyLoss and Cytotal) will be calculated 
automatically.

g  You can create an entry form in Excel to make data entry easier by selecting 
all of the fields in the top row that you need (usually P1: AN1) and, from 
Excel’s main tool bar, clicking Data > Form. Click the Tab key to move from 
field to field and click Enter to move to a new record.

h  Remember to save your work frequently.

Data Analysis

Set-up questions

Once your data are entered, either manually for those using the form, or via the PDA 
interface for those using the PDA, you can begin data analysis. 

If you are still following along with the instructions, you should be in the Storm Excel 
Template. If not, open the Template by opening the Excel file you saved in the previous 
step. Be sure the correct analysis option (Storm vs. Hurricane) is selected at the top. 

The answers to Questions 1–4 and the final question (5 for Hurricane, 8 for Storm) related 
to local cost and time estimates should be filled in with the information you entered in 
the Interface. If not, answer the questions based on the information you collected during 
Phase I: Getting Prepared. 

Question 5 for the Hurricane Adaptation asks which debris rate you want to use. This 
choice only affects Pre-Storm calculations and can be left as is for post-storm analysis. 

If you are using the Storm version (non-Hurricane), you may provide more information for 
Questions 5–7 or you can leave them marked “Unknown.”

Question 5: What was the source of your tree density numbers? Storm makes use 
of average values of tree density to estimate the amount of brush debris that will be 
created, either for pre-storm estimates or to convert meaures of canopy loss into cubic 
yards of debris. The default values come from this table:
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Estimated no. of 
trees/mile

Estimated no. of 
trees/100 ft

Cubic yards of 
debris/mile

Cubic yards of 
debris/100 ft

151–200+ 2.85–3.87+ 633.6 12

101–150 1.91–2.84 475.2 9

43–100 0.81–1.90 316.8 6

26–42 0.49–0.80 132 2.5

1–25 0.05–0.48 66 1.25

0 0 0 0

For advanced users, the default values can be adjusted in the Storm Excel Template 
under the Codes tab. If you change the values, select a response to Question 5 that 
best describes your method. Most users will wish to leave the default values as they 
are.

Question 6: What sampling method did you use? Select the most appropriate answer 
from the drop-down list.

Question 7: How did you get your post-storm information? Select the most appropriate 
answer from the drop-down list.

Completely Manual Option

In some cases, due to power outages or inaccessibility, you might not have access to your 
computer at all. In this case, you can use Forms 3 and 6 to carry out the calculations by 
hand. To do so, simply follow the instructions at the bottom of each page.

Reports

Once you’ve answered all the questions, click the PostAnalysis tab to see your storm 
damage estimates. The gray boxes contain information you entered on the Home screen. 
The numbers of trees are taken from the PostData tab. The important numbers—the hours 
of labor, total costs, and total debris—are in the upper right hand corner. The most important 
number, the storm damage cost estimate, appears in the yellow box at the very top

Printing

In Excel’s toolbar, click File > Print. The report has been set up to print the most important 
information: the results and the Removals and Hazard Pruning calculations.

aFor more information on how this table was created, see “An Initial Storm Damage Assessment 
Protocol for Urban and Community Forests” on the i-Tree website, www.itreetools.org under 
Resources.
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Appendix 1: Random Sample Workbook

These instructions are designed to help users of all skill levels create random i-Tree Storm 
sample street segments for use in field data collection. ESRI ArcGIS 9.x software is used 
(the instructions are compatible with ArcGIS v. 8 with some modifications). For purposes of 
example, US Census TIGER map data are utilized for an entire city. If zones within a city 
will be used, follow the basic directions for EACH zone.

These instructions are composed of two basic steps:

1  Prepare project area data.

2  Generate sample street segments

When you are finished, you will have created the following:

• Area-of-interest polygon map layer.

• Random street segments line map layer

Tips

• These instructions require use of basic ArcGIS functions at the ArcView level. No 
extensions are necessary.

• Advanced GIS users can primarily follow the bulleted overviews with attention 
given to the detailed instructions in areas such as field names and types.

• For advanced GIS users with Spatial Analyst: First clip the streets layers by the 
area of interest (AOI) to cut the streets at the AOI boundary. For a zones-based 
analysis, after creating a random sample segments layer, union it with a zones 
polygon layer to split the segments by zone borders.

• If desired, obtain projection/coordinate system and map unit information from the 
map data provider.

• AOI examples are large polygons such as city boundary, park areas, or individual 
management zone(s). 

• ESRI shapefiles, coverages, or geodatabases can be used. Shapefiles are easiest.

• Practice good file management using folders to hold copies of original data, folders 
to hold output, employ logical file naming, etc.

• Save your work in an ArcGIS  *.mxd project periodically through all steps.

Common tools

 Open/Browse      Select      Add Data  
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Project Area Data Preparation

Overview

• Obtain a GIS map layer representing the area-of-interest (AOI) polygon(s) for your 
project area.

• Obtain a GIS map layer representing the street centerlines for your project area.

• Launch the ArcMap application of ArcGIS at the ArcView, ArcEditor, or ArcInfo 
level.

• Save an *.mxd project file with a name and location of your choice.

• Load the AOI and streets map layers into the view.

• If needed, select the AOI polygon(s) that best represent your project area.

• Export the selected AOI polygon(s).

• If needed, select only the street lines that lay within your AOI.

• Export selected street lines.

Results

• AOI map layer composed of one or more polygons 

• Associated street lines map layer.

Detailed instructions

1  Obtain an area-of-interest (AOI) polygon from your GIS Department or an online 
resource such as ESRI’s Geography Network (www.geographynetwork.com/):

a  To obtain US Census TIGER map data, navigate your web browser to the  
Geography Network. You may need to turn off any pop-blockers in your web 
browser.

b  Under Featured Content choose Census TIGER/2000. 

c  Click the link TIGER/Line Files, Redistricting Census 2000. 

d  Select Preview and Download. 

e  Choose your state under Select a State; click Submit Selection. 

f  Choose your county under Select by County; click Submit Selection. 

www.geographynetwork.com/
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g  Under Available Data Layers, check the box next to these two files:
 
Designated Places 2000  
Line Features – Roads

h  Select Proceed to Download; select Download File. 

i  Save the file to disk and unzip into your working directory, or another 
location that you can easily find again. 

2  Launch ESRI’s ArcMap application at the ArcView (or ArcEditor or ArcInfo) level.

3  Use the Add Data button to browse to and load the TIGER Designated Places 
and Line Features – Roads map layers to the current view. If an “Unknown Spatial 
Reference” message appears, click OK to move past it.

4  TIGER Designated Places data are typically organized by county and often include 
multiple place polygons. Use the Select tool to select your specific AOI polygon 
from those on the screen. Peruse the attribute table or use the feature labeling 
functions to help identify your AOI polygon if necessary.

5   Export the selected AOI polygon(s) to a separate map layer and add the exported 
layer to the view:

a  Right-click on the TIGER Designated Places map layer and select Data > 
Export Data. 
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b  Verify that the Export drop-down list is set to Selected features. 

c  Choose an appropriate name for the AOI polygon map layer and save it.

d  When prompted, click Yes to add the exported data as a map layer to the 
view.

6  Query the TIGER Road Lines map layer to select street segments suitable for 
sampling:

a  In the Table of Contents (TOC) map layer list, click the Road Lines map 
layer to select it (verify the map layer is also checked in the TOC and thus 
visible in the map view). 

b  From the main toolbar, choose Selection > Select by Attributes.

c  In the resulting dialog window:  
 
Verify that the Road Lines map layer is 
selected from the drop-down list. 
 
Verify the chosen method is set to Create 
new selection. 
 
Copy and paste this query below into the 
query box at the bottom of the window: 
 
(“CFCC” = ‘A21’) or (“CFCC” = ‘A25’) or 
(“CFCC” = ‘A31’) or (“CFCC” = ‘A35’) or 
(“CFCC” = ‘A41’) or (“CFCC” = ‘A45’)     
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7  Perform an additional query on the selected streets to identify those that are 
WITHIN the exported AOI:

a  In the Table of Contents (TOC) map layer list, click the Road Lines map 
layer to select it (verify the map is also checked and visible).  

b  From the menu, choose Selection > Select by Location and in the 
resulting window: 

 
In the I want to drop-down box, 
choose select from the currently 
selected features in.
 
Make sure ONLY the TIGER 
Road Lines layer is checked in 
the following layer(s) list.
 
In the that dropdown box, 
choose are within (the choice 
completely within will not work 
for this operation) 
 
Make sure the AOI polygon layer 
exported above is selected in the 
the features in this layer drop-
down box. 
 
Do NOT apply a buffer to the AOI 
polygon. 
 
Click OK.

8  Export the subset of selected TIGER Road Lines to a separate map layer and add 
the  layer to the view:

a  Right-click on the TIGER Roads Lines map layer and select Data > Export 
Data. 

b  Verify that the Export drop-down list is set to Selected features. 

c  Choose an appropriate name for the selected streets line map layer and 
save it.
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d  When prompted, click Yes to add the exported data as a map layer to the 
view.

9  From the main toolbar, choose Selection > Clear Selected Features to unselect 
the AOI polygon and Streets features.

Results

Area-of-interest (AOI) polygon map layer and associated AOI Streets in a line 
layer that are suitable for sampling.

• Verify AOI polygon and Streets map layers are loaded into the map view. It 
may be necessary to right-click the new AOI layer and select Zoom to Layer.

• Right-click the new AOI layer name in the map layers list, and choose Open 
Attribute Table to verify you have the correct AOI polygon using an attribute 
field such as “name”.

• Verify the street lines do not extend past the AOI polygon.

The street lines are now ready to be sampled.
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Street Segment Sample Generation 

Overview

• Add a field to the streets data.

• Calculate random number values for the streets data.

• Select the desired number of street segment samples from the attribute table.

• Export the street sample data and map.

Results

• Random street segments for field sampling

Detailed instructions

1  On the Streets map layer, open the table by right-clicking on the layer name in the 
TOC.

2  Using the Options button, at bottom right of the table window, add a field named 
RandomSeg of type Double to the Streets table. Leave the Precision and Scale 
entries blank.
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3  Right-click the newly created RandomSeg field title and use the Field Calculator 
to populate the field using the rnd function:

4  Once the field is populated, right-click the RandomSeg field title to sort the field in 
ascending order.

5  Scroll down the attribute table to reach the desired number of street segments and 
select them:

a  Click one of the cells in the table to see which record number it is in the 
Record count box

b  When the desired number of records is found, hold down Shift while 
selecting the records using the gray buttons to the left of the records.
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6  Close the table window and return to the map view to export the selected Streets 
map layer samples and add them to the view:

a  Right-click on the Streets map layer and select Data > Export Data. 

b  Verify that the Export drop-down list is set to Selected features. 

c  Choose an appropriate name for the selected street samples map layer and 
save it.

d  When prompted, click Yes to add the exported data as a map layer to the 
view.

7  From the main toolbar, choose Selection > Clear Selected Features to unselect 
the Streets features.

8  If desired, open the newly created street samples attribute table and export the 
records for use in Microsoft Excel (for printing, etc.):

a  From the Attribute table > Options button > Export > All records

b  Choose to export as a dBase file, which can be read by MS Excel.

9  If desired, print a map of the segments for planning and field use:

a  Label the street 
segments with a name 
field in the map view.

b  Recolor the map 
layers for better visibility 
by right-clicking on their 
symbology in the TOC. 

c  Switch to the Layout view and add map elements such 
as north arrow and scale bar via the Insert menu at top.
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d  From the main toolbar, choose File > Print and select appropriate printer 
and paper.

e  Optional: choose File > Export Map to save an electronic copy of the map.

10  Optional:  For zones within an AOI, add in a zones polygon layer. Use the Select 
by location function for each zone in order to tally street sample counts within 
each zone.

Results

Desired number of random street segment samples in a LINE map layer.

MS Excel file (.dbf) of street segment samples attribute data.

Hardcopy or electronic maps of sample segments.
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This Appendix includes all of the forms needed for collecting data before or after a storm 
using the regular Storm protocol (non-Hurricane Adaptation).

Form 1: Record of Plot Length and Completion of Pre- and Post-Storm Survey

Form 2A: Pre-Storm Field Data Collection Sheet (Populated Areas)

Form 2B: Pre-Storm Field Data Collection Sheet (Rural Areas)

Form 3: Pre-Storm Community Summary Data

Form 4A: Post-Storm Field Data Collection Sheet (Populated Areas)

Form 4B: Post-Storm Field Data Collection Sheet (Rural Areas)

Form 5: Post-Storm Community Summary Data

Form 6: Local, State, and Federal Agency Contact Information

[Note: The calculations described in Forms 3 and 5 occur automatically in the 
Storm Template. The forms are provided here for your convenience and in cases of 
emergencies where calculations must be done by hand.]

Appendix 2: Data Forms (Storm)



i-Tree Storm: Form 1 

Record of Plot Length and Completion of Pre- and Post-Storm Survey 

Community Name: 
Date Pre-Storm 
Survey 
Completed: 

 Date Post-Storm 
Survey 
Completed: 

 

  =           % 

Total Plot Length 
(mi)1 

÷ 
Total Street Miles2 

× 100 
= Percent Street Miles 

Pre-Storm Survey Completed Post-Storm Survey Completed 
Plot Number Plot Length 

(feet) Initials of Data 
Collector 

Date 
Completed 

Initials of Data 
Collector 

Date 
Completed 

      

      

      

      

      

      

      

      

      

      

      

      

Total Length1 
     

1 Where necessary, convert total plot length from feet to miles by dividing it by 5,280 before entering the amount at 
the top of the form. 

2 If not using TIGER/Line files, total street mileage can be obtained from the engineering or public works 
department. Only public streets that will be included in an actual storm cleanup should be counted. 

 



i-Tree Storm: Form 2A 

PRE-Storm Field Data Collection Sheet (Populated Areas) 

Community Name: 

ON Street: 

FROM Street: TO Street: 

Date: Plot Length (ft/mi): 

Plot Number: 

ROW Width (feet): Collected by: 

 
Complete this section only if the plot is less than the full blockside. 

Start of plot description: 

End of plot description: 
 
ON Right-of-Way Trees  
(Count trees on both sides of the street) ROW + 50’ Trees1

DBH 
Class 

Tally of ROW 
Trees2 

Number of 
ROW Trees 

Time per 
Tree for 

Removal3 

Total Hours for 
Removal 

(total trees × 
time per tree) 

Time Per 
Hazard 
Prune4 

Total Hours 
Haz Prune 

(total trees × 
time per tree)

DBH 
Class 

Tally Off 
ROW 
Trees 

Total Off 
ROW 
Trees 

TOTALS 

6-12   3.2  0.75  6-12    

13-18   5.1  1.0  13-18    

19-24   7.7  1.5  19-24    

25-30  10.2  2.0  25-30    

31-36   12.5  3.0  31-36    

37-42   20.4  4.0  37-42    

43+   28.0  5.0  43+    

Totals           
 

1 Rate all trees as a group that fall within 50 feet of the edge of the right-of-way. 
2 Record each tree with a tally mark, then place the total number of marks in the next column. 
3 Time for removal does not include stump removal (see Protocol). 
4 Time for hazard pruning is for removal of broken or hazardous branches greater than 2 inches only (see Protocol). 
 



i-Tree Storm: Form 2B 

PRE-Storm Field Data Collection Sheet (Rural Areas) 

Community Name: 

ON Road:  

Intersection nearest to plot start: 

Approximate distance to intersection: 

Plot Number: 

Date: Plot Length (mi): 

ROW Width (feet): Collected by: 

 
Indicate here permanent features (such as poles, signs, driveways, etc.) that help locate 
the plot. 

Start of plot: 

End of plot: 
 
 
 

ON Right-of-Way Trees  
(Count trees on both sides of the road) 

Tally of 
ROW 

Trees1 

Number of 
ROW 
Trees 

Avg. 
Time per 
Removal

2 

Total Hours 
Removal 

(total trees × 
time per removal)

Avg. Time Per 
Prune3 

Total Hours 
Hazard Prune 
(total trees × 

time per prune)

   

2.5 

 

Totals      
 

1 Record all trees >6” with a tally mark, then place the total number of marks in the next column. 
2 Time reduced 50% from urban rate to account for simpler procedure. It does not include stump removal.  
3 Time reduced 50% from urban rate. It includes pruning of broken or hazardous branches greater than 4 inches 

only. 
 



i-Tree Storm: Form 3 – Page 1 

PRE-Storm Community Summary Data 

Plot 
Number 

Total Hours 
Removal3 

Total Hours 
Prune 

Total ROW 
Trees 

Total All Trees  
(rural: only in 

ROW) 

Plot 
Length 
(feet)2 

Tree Density per 100 
ft. (total trees in plot 
× 100 ÷ plot length) 

Brush7 
(cubic yards 

per 100 
feet) 

Total Brush (plot 
length × brush ÷ 

100) (cubic 
yards)5 

        
         
         
         
         
         
         
         
         
         
         
         
         
         
         
         
         
         
         
         
         
         
         
         
         
         

Totals        
 



i-Tree Storm: Form 3 – Page 2 

PRE-Storm Community Summary Data 

Community 
Name: 

 

State: Date: Total Street Miles1: Total Plot Length2 (mi):     

 

hrs mi mi hrs
Total Hours3 

× 
Total Street Miles 

÷
Total Plot Length 

=
Total Removal Hours 

hrs $  0.2 $ 
Total Removal Hours 

× 
Cost per Hour4 

× 
Tree Removal Percentage 

=
Tree REMOVAL Cost 

 

hrs mi mi hrs
Total Hours3 

× 
Total Street Miles 

÷ 
Total Plot Length 

=
Total Pruning Hours 

hrs $ 0.3 $ 
Total Pruning Hours 

× 
Cost per Hour4 

× 
Tree Pruning Percentage 

=
Tree PRUNING Cost 

 

cu yd mi mi cu yd
Total Brush5 

× 
Total Street Miles 

÷ 
Total Plot Length 

=
Total Brush 

cu yd $ $ 
Total Brush 

× 
Cost per cubic yard6 

=
BRUSH Clean-Up Cost 

 

$ $ $ $ 
Tree Removal Cost 

+ 
Tree Pruning Cost 

+
Brush Clean-Up Cost 

=
Final Clean-Up Cost 

For complete instructions on how to use this form, see the paper “An Initial Storm Damage Assessment Protocol for 
Urban and Community Forests” on the i-Tree website, www.itreetools.org under Resources. 
1 Total street miles in the community or in the area being surveyed. 
2 If total plot length is in feet at the bottom of Form 3 -- Page 1, divide by 5280 feet to obtain miles. 
3 Enter the total hours for all plots from the bottom of Form 3 -- Page 1. 
4 Cost can be provided by local community based on past experience, or a default cost of $45–$65 per man-hour 

for a fully equipped crew can be used. 
5 Enter the total brush in cubic yards from the bottom of Form 3 -- Page 1.  
6 Brush cleanup costs range typically between $5 and $15 per cubic yard. These costs vary based on local conditions. 
7 Determine the brush in yards per 100’ based on tree density from Table G-1 in the document referenced above, 

making sure to use the far right column. Then enter that number for each plot on Form 6. 



i-Tree Storm: Form 4A 

POST-Storm Field Data Collection Sheet (Populated Areas)  

Community Name1: 

ON Street: 

FROM Street: TO Street: 

Date: Plot Length (ft/mi): 

Plot Number1:

ROW Width (feet): Collected by: 
 

Start of plot description: 

End of plot description: 
 

ROW Trees ONLY ROW + 50’ Trees2

Tree Removals Tree Pruning Debris Estimate3 

DBH 
Class 

Tally 
Number 

of 
Removal 

Trees 

Total All 
Removal 

Trees 

Time 
Per 
Tree 

(hours) 

Total Hours 
for Removal 
(total trees × 
time per tree)

Tally 
Hazard 
Prune 
Trees 

Total 
All 

Hazard 
Prune 
Trees 

Time 
Per 
Tree 

(hours)

Total Hours 
Haz Prune 

(total trees × 
time per tree)

Rate in 
100-Foot 
Segments 

CROWN 
LOSS4 

CUBIC 
YARDS

6-12   3.2    0.75  0-100   

13-18   5.1    1.0  101-200   

19-24   7.7    1.5  201-300   

25-30   10.2    2.0  301-400   

31-36   12.5    3.0  401-500   

37-42   20.4    4.0  501-600   

43+   28.0    5.0  601-700   

Totals         701-800   

Extra5    

Total CL   

Average6 
  

Total CY   

1 If plot information was recorded during set up, just fill in name and plot 
number. 

2 Rate all trees as a group that fall within 50 feet of the edge of the right-of-
way. 

3 Choose either Crown Loss or Cubic Yards for the whole plot.  
4 Estimate Crown Loss with one of these values: 12.5 (0-25%), 37.5 (26-50%), 

62.5 (51-75%), or 87.5 (76-100%). 
5 For plots longer than 800 feet, report average (Crown Loss) or total (Cubic 
Yards) of the remainder of the plot beyond 800 feet in the correct column here. 
6 Average = Total ÷ number of 100-foot segments examined. 

 



i-Tree Storm: Form 4B 

POST-Storm Field Data Collection Sheet (Rural Areas) 

Community Name1: 

ON Road:  

Intersection nearest to plot start: 

Approximate distance to intersection: 

Plot Number1:

Date: Plot Length (feet): 

ROW Width (feet): Collected by: 
 

Start of plot: 

End of plot: 
 

 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1 If road and plot information was recorded during set up, just fill in name and plot 
number. 

2 On rural roads, removals are only recorded for large trees already in failure. Time has 
been reduced 50% from the urban rate, and excludes stump removal. 

3 On rural roads, time per prune is for pruning of broken or hazardous branches greater 
than 4 inches only. Time has been reduced 50% from the urban rate, and does not 
include other pruning. 

4 Choose Crown Loss or Cubic Yards for the plot. Estimate Crown Loss with one of these values: 12.5 (0-
25%), 37.5 (26-50%), 62.5 (51-75%), or 87.5 (76-100%). 

5 For plots longer than 800 feet, report average (Crown Loss) or total (Cubic Yards) of the rest of the plot 
beyond 800 feet in the correct column here. 

6 Average = Total CL ÷ # of 100’ segments 

 

ON Right-of-Way Trees  
(Count trees on both sides of the road) 

Tally of 
hazardous 

removal ROW 
trees 

Total 
Number of 
hazardous 
removal 

ROW Trees 

Avg. 
Time2 per 
Removal 

Total Hours 
Removal 

(total trees 
× time per  
removal) 

Tally of 
hazardous 
prune ROW 

trees 

Total 
Number of 
hazardous 
prune ROW 

trees 

Avg. 
Time3 

Per 
Prune

Total Hours 
Hazard 
Prune 

(total trees
 × time per 

prune) 

 

     
Totals 

       

Debris estimate4 

Rate in 100-
Foot 

Segments 

Crown 
Loss 

Cubic 
Yards 

0-100   

101-200   

201-300   

301-400   

401-500   

501-600   

601-700   

701-800   
Extra5   
Total CL   

Average6  

Total CY   



i-Tree Storm: Form 5 

POST-Storm Community Summary Data 
 

Plot 
Number 

Plot Length 
(feet) 

Total Removal 
(hours)2 

Total Hazard 
Pruning 
(hours)2 

Brush per 100 
ft. (from the 
pre-storm 
analysis) 

Average 
Canopy Loss 

Adjusted 
Brush5 Total Brush (cu yd)5 

        
        
        
        
        
        
        
        
        
        
        
        
        
        
        
        
        
        
        
        
        
        
        
        
        
        

Totals 
      

 



i-Tree Storm: Form 5 (Cont.) 

POST-Storm Community Summary Data 

Community 
Name: 

 

State: Date: Total Street Miles1: Total Plot Length (mi)1:     

 

hrs mi mi hrs
Total Hours3 

× 
Total Street Miles 

÷
Total Plot Length 

=
Total Removal Hours 

 hrs $ $ 
8 

 
Total Removal Hours 

× 
Cost per Hour4 

=
Tree REMOVAL Cost 

 

hrs mi mi hrs
Total Hours3 

× 
Total Street Miles 

÷
Total Plot Length 

=
Total Pruning Hours 

 hrs $ $ 
 

 
Total Pruning Hours 

× 
Cost per Hour4 

=
Tree PRUNING Cost 

 

  cu yd mi mi cu yd
Total Brush5 

× 
Total Street Miles 

÷
Total Plot Length 

=
Total Adjusted Brush 

 cu yd $ $ 
 

 
Total Adjusted Brush 

× 

Cost per yard4 
=

BRUSH Clean-Up Cost 

 

$ $ $ $ 
Tree Removal Cost 

+ 
Tree Pruning Cost 

+
Brush Clean-Up Cost 

=
FINAL Clean-Up Cost 

For complete instructions on how to use this form, see the paper “An Initial Storm Damage Assessment Protocol for 
Urban and Community Forests” on the i-Tree website, www.itreetools.org under Resources. 

1 Plot number, plot length, and total street miles should be filled in from pre storm data. If total miles and total plot  
lengths are different than original estimate, enter the new miles. 
2 Sum all the plot totals to obtain total hours of tree removal and hazard pruning cleanup. 
3 Cost per man-hour for a fully equipped crew to do removal and pruning work. Note that this hourly figure may be 

different than the $45–65 per man-hour range that was suggested in the pre-storm cleanup estimate. 
4 Average brush cleanup cost is between $5 and $15 per cubic yard. The post-storm cost may differ from these pre-

storm estimates. 
5 If using the crown loss method, Total Brush = plot length × Adjusted brush ÷ 100. Total Brush comes from Form 3 

(Page 1), and Adjusted brush is estimated from Table G-2 in the document referenced above, using the Total Brush 
estimates and the average post-storm canopy loss in the plot. If visually estimating cubic yards of debris, enter the 
numbers directly. 



i-Tree Storm: Form 6 

Local, State, and Federal Agency Contact Information 
Local Contact 

Contact Name: Telephone: 

Office/Agency: Fax: 

Department: E-mail: 

Address: Date Sent: 

City/State/Zip: Overnight Mail Carrier No.:  
State Contact 

Contact Name: Telephone: 

Office/Agency: Fax: 

Department: E-mail: 

Address: Date Sent: 

City/State/Zip: Overnight Mail Carrier No.: 
 
Federal Contact 

Contact Name: Telephone: 

Office/Agency: Fax: 

Department: E-mail: 

Address: Date Sent: 

City/State/Zip: Overnight Mail Carrier No.: 
 
Other Contact 

Contact Name: Telephone: 

Office/Agency: Fax: 

Department: E-mail: 

Address: Date Sent: 

City/State/Zip: Overnight Mail Carrier No.: 
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This Appendix includes all of the forms needed for collecting data before or after a storm 
using the Hurricane Adaptation protocol.

Form 1: Record of Plot Length and Completion of Pre- and Post-Storm Survey

Form 2A: Pre-Storm Field Data Collection Sheet (Populated Areas)

Form 2B: Pre-Storm Field Data Collection Sheet (Rural Areas)

Form 3: Pre-Storm Community Summary Data

Form 4A: Post-Storm Field Data Collection Sheet (Populated Areas)

Form 4B: Post-Storm Field Data Collection Sheet (Rural Areas)

Form 5: Post-Storm Community Summary Data

Form 6: Local, State, and Federal Agency Contact Information

[Note: The calculations described in Forms 3 and 5 occur automatically in the 
Storm Template. The forms are provided here for your convenience and in cases of 
emergencies where calculations must be done by hand.]

Appendix 3: Data Forms (Hurricane)



i-Tree Storm (Hurricane Adaptation): Form 1 

Record of Plot Length and Completion of Pre- and Post-Storm Survey 

Community Name: 
Date Pre-Storm 
Survey 
Completed: 

 Date Post-Storm 
Survey 
Completed: 

 

  =           % 

Total Plot Length 
(mi)1 

÷ 
Total Street Miles2 

× 100 
= Percent Street Miles 

Pre-Storm Survey Completed Post-Storm Survey Completed 
Plot Number Plot Length 

(feet) Initials of Data 
Collector 

Date 
Completed 

Initials of Data 
Collector 

Date 
Completed 

      
      
      
      
      
      
      
      
      
      
      
      
      
      
      
      
      
      
      
      
      
      
      
      
      

Total Length1 
     

1 Where necessary, convert total plot length from feet to miles by dividing it by 5,280 before entering the amount at 
the top of the form. 

2 If not using TIGER/Line files, total street mileage can be obtained from the engineering or public works 
department. Only public streets that will be included in an actual storm cleanup should be counted. 

 



i-Tree Storm (Hurricane Adaptation): Form 2A 

PRE-Storm Field Data Collection Sheet (Populated Areas) 

Community Name: 

ON Street: 

FROM Street: TO Street: 

Date: Plot Length (ft/mi): 

Plot Number: 

ROW Width (feet): Collected by: 

 
Complete this section only if the plot is less than the full blockside. 

Start of plot description: 

End of plot description: 
 
 

Complete this section only if pruning or removal will be 
calculated separate from debris. 

ON Right-of-Way Trees (both sides) 
Removal 
factor2 Prune factor3

DBH 
Class 
(in) 

Tally of ROW 
Trees1 

Number of 
ROW Trees 

hrs unit

Total for 
Removal 

(total trees × 
Removal 
factor) 

hrs unit

Total for 
Hazard Prune 
(total trees × 
Prune factor) 

6-12   3.2 1  0.75 1  

13-18   5.1 1  1.0 1  

19-24   7.7 1  1.5 1  

25-30  10.2 1  2.0 1  

31-36   12.5 1  3.0 1  

37-42   20.4 1  4.0 1  

43+   28.0 1  5.0 1  

Totals       
1 Record each tree with a tally mark, then place the total number of marks in the next column. 
2 Time for removal ignores stump removal (see Manual).  
3 Time for hazard pruning is for removal of broken or hazardous branches greater than 2 inches only (see Manual). 
NOTE: Multiply by the unit factor when a single price is applied to hazard removal and pruning irrespective of DBH. 



i-Tree Storm (Hurricane Adaptation): Form 2B 

PRE-Storm Field Data Collection Sheet (Rural Roads) 

Community Name: 

ON Road:  

Intersection nearest to plot start: 

Approximate distance to intersection: 

Plot Number: 

Date: Plot Length (mi): 

ROW Width (feet): Collected by: 

 
Indicate here permanent features (such as poles, signs, driveways, etc.) that help locate 
the plot. 

Start of plot: 

End of plot: 
 
 
 

Complete this section only if pruning or removal will be calculated separate 
from debris. 

ON Right-of-Way Trees (both sides) 

Tally of 
ROW 

Trees1 

Number of 
ROW Trees Removal factor2

Total for Removal 
(total trees × Removal 

factor) 

Prune 
factor3 

Total for Prune 
(total trees × Prune 

factor) 

  

6.2  1  

 

 2.5  1 

 

Totals      
 

1 Record all trees >6” with a tally mark, then place the total number of marks in the next column. 
2 Time reduced 50% from urban rate to account for simpler procedure. It does not include stump removal.  
3 Time reduced 50% from urban rate, restricted to pruning of broken or hazardous branches greater than 4 inches. 
 
NOTE: FEMA may not reimburs costs for work completed in unimproved locations—check the Applicant’s 
Handbook. 



i-Tree Storm (Hurricane Adaptation): Form 3 – Page 1 

PRE-Storm Community Summary Data 

Plot 
Number 

Total for 
Removal 

Total for 
Prune 

Plot 
Length 
(feet) 

Brush 
(cubic yards 

per 100 
feet) 1 

Total Brush (plot 
length × brush ÷ 

100) (cubic 
yards) 

     
      
      
      
      
      
      
      
      
      
      
      
      
      
      
      
      
      
      
      
      
      
      
      
      
      
      
      
      
      
      

Totals     
 

   For complete instructions on how to use this form, see the paper “An Initial Storm Damage Assessment 
Protocol for Urban and Community Forests” on the i-Tree website, www.itreetools.org under Resources. 
 

1Enter the debris rate per hundred feet from the table in the above document according to the level you would 
like to use. 



i-Tree Storm (Hurricane Adaptation): Form 3 – Page 2 

PRE-Storm Community Summary Data 

Community 
Name: 

 

State: Date: Total Street Miles1: Total Plot Length2 (mi):     

 

 mi mi
Total Hours/Units3 

× 
Total Street Miles 

÷
Total Plot Length 

=
Total Removal Hours/Units 

 $  0.2 $ 
Total Removal 
Hours/Units 

× 
Cost per Hour/Unit4 

× 
Tree Removal Percentage 

=
Tree REMOVAL Cost 

 

 mi mi
Total Hours/Units3 

× 
Total Street Miles 

÷ 
Total Plot Length 

=
Total Pruning Hours/Units 

 $ 0.3 $ 
Total Pruning 
Hours/Units 

× 
Cost per Hour/Unit5 

× 
Tree Pruning Percentage 

=
Tree PRUNING Cost 

 

cu yd mi mi cu yd
Total Brush6 

× 
Total Street Miles 

÷ 
Total Plot Length 

=
Total Brush 

cu yd $ $ 
Total Brush 

× 
Cost per cubic yard7 

=
BRUSH Clean-Up Cost 

 

$ $ $ $ 
Tree Removal Cost 

+ 
Tree Pruning Cost 

+
Brush Clean-Up Cost 

=
Final Clean-Up Cost 

1 Total centerline street miles which you maintain in the community or in the area being surveyed.  Typically these do 
not include private and federal roads. 

2 If total plot length is in feet at the bottom of Form 3 -- Page 1, divide by 5280 feet to obtain miles. 
3 Enter the total hours/units for all plots from the bottom of Form 3 -- Page 1. 
4 If local costs are unavailable, a default cost of $55 per man-hour for a fully equipped crew or a unit price of $450 

can be used. 
5 If local costs are unavailable, a default cost of $55 per man-hour for a fully equipped crew or a unit price of $145 

can be used. 
6 Enter the total brush in cubic yards from the bottom of Form 3 -- Page 1.  
7 If local costs are unavailable, a default cost of $21.50 may be used. 



i-Tree Storm (Hurricane Adaptation): Form 4A 

POST-Storm Field Data Collection Sheet (Populated Areas)  

Community Name: 

ON Street: 

FROM Street: TO Street: 

Date: Plot Length (ft/mi): 

Plot Number: 

ROW Width (feet): Collected by: 
 

Start of plot description: 

End of plot description: 
 
 
Complete the section below only if you will calculate pruning or removal 
separate from debris. 

ROW Trees ONLY 
Tree Removals1 Tree Pruning1 

Removal 
factor  

Prune 
factor   DBH 

Class 
(in) 

Tally 
Number 

of 
Removal 

Trees 

Total All 
Removal 

Trees hrs unit 

Total for 
Removal 

(total trees ×
Rem factor)

Tally 
Hazard 
Prune 
Trees 

Total All 
Hazard 
Prune 
Trees hrs unit

Total for 
Prune 

(total trees × 
Pr factor) 

6-12   3.2 1    0.75 1  

13-18   5.1 1    1.0 1  

19-24   7.7 1    1.5 1  

25-30   10.2 1    2.0 1  

31-36   12.5 1    3.0 1  

37-42   20.4 1    4.0 1  

43+   28.0 1    5.0 1  

         

         

Totals         
 

 

1 Select hourly rate or unit price depending on how you are calculating costs.  
2 Include by vsual estimate any debris within 50’ of the ROW. 
3 Beyond 800 feet, report total Cubic Yards for the remainder of the plot. 
 

Debris estimate2

Rate in 100-
Foot 

Segments 

Cubic 
Yards 

0-100  

101-200  

201-300  

301-400  

401-500  

501-600  

601-700  

701-800  
Extra4  

Total CY  



i-Tree Storm (Hurricane Adaptation): Form 4B 

POST-Storm Field Data Collection Sheet (Rural Areas) 

Community Name: 

ON Road:  

Intersection nearest to plot start: 

Approximate distance to intersection: 

Plot Number: 

Date: Plot Length (feet): 

ROW Width (feet): Collected by: 
 

Start of plot: 

End of plot: 
 

 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1 Select hourly rate or unit price depending on how you are calculating costs. 
2 On rural roads, removals are only recorded for large trees already in failure. Time has 

been reduced 50% from the urban rate, and excludes stump removal. 
3 On rural roads, time per prune is for pruning of broken or hazardous branches greater 

than 4 inches only. Time has been reduced 50% from urban rate. 
4  Beyond 800 feet, report total Cubic Yards for the remainder of the plot. 

Complete the section below only if you will calculate pruning or removal 
separate from debris. 

ON Right-of-Way Trees1 (both sides) 

 Removal 
factor2 

Prune 
factor3  Tally of hazard 

removal ROW 
trees 

Total of 
hazard 

removal 
ROW Trees hrs unit 

Total for 
Removal 

(total trees 
× Removal 

factor) 

Tally of 
hazard 

prune ROW 
trees 

Total of 
hazard
prune 
ROW 
trees hrs uni

t 

Total for 
Prune 

(total tree
s × Prune 

factor) 

 

 

6.2 1 

  

2.5 1 

Totals 

       

Debris estimate

Rate in 100-
Foot 

Segments 

Cubic 
Yards 

0-100  

101-200  

201-300  

301-400  

401-500  

501-600  

601-700  

701-800  
Extra4  

Total CY  



i-Tree Storm (Hurricane Adaptation): Form 5 

POST-Storm Community Summary Data 
 

Plot 
Number 

Plot Length 
(feet) Total Removals Total Pruning Total Brush (cu yd) 

     
     
     
     
     
     
     
     
     
     
     
     
     
     
     
     
     
     
     
     
     
     
     
     
     
     
     
     
     
     
     
     

Totals 
    

 



i-Tree Storm (Hurricane Adaptation): Form 5 (Cont.) 

POST-Storm Community Summary Data 

Community 
Name: 

 

State: Date: Total Street Miles1: Total Plot Length (mi)1:     

 

 mi mi
Total Removal 
Hours/Units3 

× 
Total Street Miles 

÷
Total Plot Length 

=
Total Removal Hours/Units 

 $ $ 

8 

 
Total Removal 
Hours/Units 

× 
Cost per Hour/Unit4 

=
Tree REMOVAL Cost 

 

 mi mi
Total Hours/Units3 

× 
Total Street Miles 

÷
Total Plot Length 

=
Total Pruning Hours/Units 

 hrs $ $ 
 

 
Total Prune Hours/Units 

× 
Cost per Hour/Unit4 

=
Tree PRUNING Cost 

 

  cu yd mi mi cu yd
Total Brush5 

× 
Total Street Miles 

÷
Total Plot Length 

=
Total Adjusted Brush 

 cu yd $ $ 
 

 
Total Adjusted Brush 

× 

Cost per yard4 
=

BRUSH Clean-Up Cost 

 

$ $ $ $ 
Tree Removal Cost 

+ 
Tree Pruning Cost 

+
Brush Clean-Up Cost 

=
FINAL Clean-Up Cost 

1 Plot number, plot length, and total street miles should be filled in from pre-storm data. If total miles and total plot 
lengths are different than original estimate, enter the new miles. 

2 Sum all the plot totals to obtain total tree removal and hazard pruning. 
3 Cost per man-hour for a fully equipped crew or cost per unit.  May be different than the $45–65 per man-hour 

range that was suggested in the pre-storm cleanup estimate. 
4 Average brush cleanup cost is between $15 and $25 per cubic yard. The post-storm cost may differ from these 
pre-storm estimates. 



i-Tree Storm: Form 6 

Local, State, and Federal Agency Contact Information 
Local Contact 

Contact Name: Telephone: 

Office/Agency: Fax: 

Department: E-mail: 

Address: Date Sent: 

City/State/Zip: Overnight Mail Carrier No.:  
State Contact 

Contact Name: Telephone: 

Office/Agency: Fax: 

Department: E-mail: 

Address: Date Sent: 

City/State/Zip: Overnight Mail Carrier No.: 
 
Federal Contact 

Contact Name: Telephone: 

Office/Agency: Fax: 

Department: E-mail: 

Address: Date Sent: 

City/State/Zip: Overnight Mail Carrier No.: 
 
Other Contact 

Contact Name: Telephone: 

Office/Agency: Fax: 

Department: E-mail: 

Address: Date Sent: 

City/State/Zip: Overnight Mail Carrier No.: 
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